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StudyMate Author Registration 

On-line Help & User Guides 

 

 

Introduction  

StudyMate Author
®
 by Respondus

®
 is a Windows authoring tool that makes it easy to 

create web-based learning activities and games. When creating a StudyMate file, the 

focus is on the substance of a topic, not the requirements of a particular activity or game. 

This is a more natural approach for instructors and makes it easier to use content that 

might already exist in other formats.   

 

Four types of items can be created or imported by StudyMate Author: Fact items, 

Term/Definition items, Multiple Choice, and Calculated items. All four item types can 

reside in the same StudyMate file.  

 

ñFactò Items 

A ñFactò item consists of a fact, a statement, or a body of text. The following fact would 

be an example of a Fact item: Albert Michelson determined the speed of light in 1879. 

The StudyMate Author activities that can be generated with Fact items include: 

Fact Cards  

Fact Cards + 

 

ñTerm/Definitionò Items 

A ñTerm/Definitionò item has a word/phrase that is associated with another word/phrase. 

A common example is a glossary ñtermò that has a related ñdefinition.ò Another example 

is a fill -in-the-blank ñquestionò in which the ñanswerò is a specific word or phrase. The 

StudyMate Author activities that can be generated using Term/Definition items include: 

 

Flash Cards 

Pick a Letter 

Fill in the Blank 

Matching 

Crosswords 

Glossary 

  

ñMultiple Choiceò Items 

ñMultiple Choiceò items are questions that have multiple distracters but only one correct 

answer. The StudyMate Author activities that can be created with Multiple Choice items 

include:  

 

Quiz 

Challenge 
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"Calculated" Items 

"Calculated" items, sometimes known as algorithmic items, require students to apply a 

mathematical formula to answer the question presented.  Calculated items are designed 

for using variables with random values, based on a specified range, that are automatically 

generated for each variable in the question.  The StudyMate Author activities that can be 

created with Calculated items include: 

 

Quiz 

Challenge 

 

StudyMate Author exports the activities and games to StudyMate.com with a web link 

the instructor can post to anywhere and is accessible by students with a web browser 

including most mobile web browsers on smartphones and similar handheld devices.  

 

StudyMate Author additionally offers direct integration with ANGEL (version 6.3 and 

higher), Blackboard Learning System (version 7.3 or higher), Blackboard Learn (version 

9.x or higher), and Blackboard Vista/Campus Edition (version 8.0) with links to the 

activities on StudyMate.com, as Adobe Flash (.swf) activities or as SCORM 1.2+ 

modules. 

 

StudyMate Author will  also export the activities and games in Adobe Flash (.swf) format 

that instructors can upload to other learning management system such as Moodle, 

Desire2Learn and Instructure Canvas along with any web site, web service or web 

application that supports Adobe Flash (.swf) files.  

 

Computer Requirements 

StudyMate Author requires Windows XP or higher, 32 MB of RAM, 5 MB of free hard 

disk space, and at least an 800x600 monitor resolution (1024 x 768 recommended). For 

previewing activities, Internet Explorer must have the Adobe Flash Player installed 

(version 7.0 or higher). 

 

 

Installation & Setup 

To begin the installation process, download the StudyMate installation file from 

http://www.respondus.com for the StudyMate Single-user license. For StudyMate 

Campus-wide licenses, obtain the installation file from the institution's Respondus 

Campus-wide Local Support Contacts. Once the file has been downloaded; locate the 

StudyMate25.exe file (or StudyMate25Campus.exe) that was downloaded to your hard 

drive. Double-click the file to start the StudyMate Author installation program and follow 

the instructions on the screen. Once StudyMate Author is installed, start the program by 

double-clicking the StudyMate Author icon that appears on the Windows desktop. Or, 

follow these steps to start the software. 

 

1. Click [Start] from the Windows desktop 

2. Click [Programs] 

http://www.respondus.com/
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3. Click [Respondus] 

4. Click [StudyMate Author] 

 

The first time you start StudyMate Author (and each time thereafter until the program is 

registered), you will be presented with a screen to register StudyMate Author 2.5. 

 

StudyMate Author  Registration 

 

StudyMate Author Single-User license  

 

The first time you start StudyMate Author (and each time thereafter until the program is 

registered), you will be presented with a screen that provides the ñProduct ID#ò. The 

Product ID# is used to obtain the Activation Password (see below) which is needed to 

complete the installation. 

 

Once the StudyMate Author installation program is finished, you will need to obtain a 

password from www.respondus.com to activate the installation. Be sure to have the 

StudyMate Author ñProduct ID#ò readily available. After you have directed your browser 

to http://www.respondus.com, go to the ñRegistrationò section of the site. You have the 

choice of purchasing a permanent activation password for StudyMate Author or obtaining 

a 30-day trial password. In both cases you will be required to enter a valid e-mail address 

and the Product ID# that displays on the opening screen of StudyMate Author. Once the 

information is submitted, the activation password is immediately sent to the e-mail 

address you specified.  

 

Once the password is received by e-mail, it must be entered into the StudyMate Author 

program. If you havenôt done so already, start StudyMate Author and then enter the 

password when prompted (you may want to ñcopy and pasteò the password from the e-

mail message in order to prevent typing mistakes). Click [OK] to continue. The 

StudyMate Author software is now activated, either permanently or for a 30-day trial 

period.  

 

StudyMate Author Campus-wide License 

 

The first time you start StudyMate Author, you will be presented with a screen prompting 

for your institution's Campus-wide license information. Please contact your institution's 

Respondus Campus-wide Local Support for the license information and additional 

assistance with registering the Campus-wide license. 

 

Online Help & User Guides 

StudyMate Author includes a full-featured help system that includes an index and 

context-sensitive help. To view the on-line help, choose ñHelp Topicsò from the pull-

down Help menu and select a topic. You can also press the F1 key from within 

StudyMate Author to obtain context-sensitive help. Throughout the program you will 

additionally see small buttons having a ñ?ò symbol. When the button is clicked, 

information on that particular option or task is provided.  

http://www.respondus.com/
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If you encounter a question that is not answered in the online help or in the StudyMate 

Author User Guide, you are encouraged to visit the ñSupportò section of the Respondus 

web site (www.respondus.com). There you will find a Knowledge Base and other 

resources.  

 

The remainder of this user manual is organized according to the five StudyMate Author 

menus: Start, Edit , Settings, Preview & Publish, and StudyMate.com. 
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Start Menu  

Overview of Start Menu 

Opening a File 

Opening and Converting a Respondus file 

Downloading Publisher Test Banks 

Creating a File 

Import Wizard  

Quick Copy Wizard 

 

 

Overview of Start Menu 

The Start menu provides the ability to Open a StudyMate Author file, Create a new file, 

and Import  questions from a word processing, text, or IMS QTI file. The Quick Copy 

Wizard  additionally provides an easy way to create an activity from an existing set of 

StudyMate files.  

 

A StudyMate file must be open before you can go to another menu in StudyMate Author. 

 

 

Opening a File 

From the Start menu, click the Open button. The following window will appear: 

 

 
 

Highlight a StudyMate project by clicking it once. To obtain information on the project, 

select one of the two center buttons located above the ñSelected Fileò window at right. 

The ñItem Listò button (right of center) is used to view a list of the items contained in the 

highlighted file. To preview a particular item, click the ñTitle.ò 

 

To open a highlighted file, click the [Open] button at the bottom of the window. 

(Double-clicking a file name will also open it.)  

 

StudyMate Author allows projects to be organized within sub-folders. For example, you 

may want to organize StudyMate projects by class, course, or subject matter. To create a 

new folder, locate the toolbar above the ñSelected Fileò window and click the ñCreate 

New Folderò button located second from left. To navigate down a level within a folder, 

double-click the folder itself. To navigate up a level, click the ñUp One Levelò button 
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located leftmost on the row of buttons. To save a StudyMate Author file into a subfolder, 

open the StudyMate Author file, select "Save Asé" from the File menu and navigate to 

the new subfolder when prompted for a file name and location. 

 

The [Search] button allows the text in a file to be searched prior to opening it.  

 

The [Browseé] button, located on the lower left side of the Open window, allows you to 

locate a StudyMate file (.rsf) that is located elsewhere on the hard drive and copy the file 

to the StudyMate Projects folder. It does not move the file or open it directly; rather, it 

creates a new ñprojectsò folder based on that file.  

 

The [Download Test Bank] button is used to start the Respondus Test Bank Network 

wizard to register and download a publisher test bank 

 

Opening and Converting a Respondus file 

 

The Browse button can also be used to select and then convert a Respondus project file 

(.rsp) or a Respondus archive file (.rsa, .rpa) to StudyMate format. To do so, click 

[Browse...] and then change the pull-down list for ñFiles of Typeò to ñRespondus Files 

and Archives.ò Upon selecting a Respondus project or archive file, various options will 

be offered regarding the conversion of the Respondus file to StudyMate format. Select 

the desired options and click [OK] to complete the conversion. 

 

Note, the Import Wizard can also be used to convert a Respondus file to StudyMate 

format. 

 

Downloading Publisher Test Banks 

 

The [Download Test Bank] button is used to download publisher test banks that have 

been made available through the Respondus Test Bank Network (for more details, see 

http://www.respondus.com/testbank). To download a test bank, enter the File Code that 

has been supplied to you by the publisher. If applicable, also enter the password and any 

additional information that has been provided to you. StudyMate Author will then locate 

and download the test bank file. Since the file being downloaded is in Respondus format, 

it will need to be converted to StudyMate format. Following the download step, 

StudyMate Author will display various options regarding the conversion of the file to 

StudyMate format. Select the desired options and click [OK] to complete the conversion. 

 

 

Creating a File 

From the Start menu, select the Create button to create a new file. You are prompted to 

enter a File Name and Description (both are required), as well as Author and Keyword 

information (optional). Click [OK]  to create the file. You are now ready to add items to 

the file, using either the Edit menu or the Import Wizard.  

 

http://www.respondus.com/testbank
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Import Wizard  

StudyMate Author allows the importing of Fact, Term/Definition, and Multiple Choice 

items.  Calculated items can also be imported, but only if they are in Respondus (.rsp) 

format. For text imports, the file must be formatted according to the guidelines discussed 

later in this section. Once the text is in the proper formatting, the Import Wizard will 

guide you through the importing process, as discussed here.   

 

Step 1 

Start the Import Wizard and select the file format being imported:  

 

* MS Word 2007-10 (.docx) 

*  MS Word 97-2003 (.doc), Rich Text (.rtf), Text (.txt) 

*  IMS QTI (.xml) 

*  Respondus (.rsp) or Respondus Archive (.rsa, .rpa) 

* StudyMate Class format (.zip, .xml) 

 

 
 

 

The first two options (.docx, .doc, .rtf, .txt) are self-explanatory. If the file being 

imported is in one of these formats, then select one of these two options. 

 

Note: Importing questions from the Microsoft Word 2007-2010 .docx format 

requires that Word 2007 or Word 2010 be installed on the same computer. The 

.docx format has better support for importing text with formatting like auto-

numbers and auto-letters along with embedded images. 

 

 

IMS Question & Test Interoperability (IMS QTI) is a series of specifications that 

are supported by various e-learning systems (for more information, see 

http://www.imsglobal.org/question/). If an IMS QTI XML file is being imported, 

StudyMate Author will use only the multiple choice and true/false questions, 

filtering out the rest of the content.  
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Respondus is a separate authoring tool by Respondus Inc. that allows you to 

create assessment content for use with the leading course management systems 

(for more information, see http://www.respondus.com). Many question types from 

Respondus files (.rsp) or Respondus Archive Files (.rsa, .rsp) can be imported 

with StudyMate Author. 

 

StudyMate Class is a separate application and a web-based version of StudyMate 

that resides within the online course. Files can be exported from a StudyMate 

Class project for import into StudyMate Author. Respondus files can also be 

saved as StudyMate Class format files for import into either StudyMate Author or 

StudyMate Class. 

 

 

Step 2 

If you are importing an IMS QTI XML file, Respondus file or StudyMate Class 

file, skip to the instructions provided in Step 3. For MS Word .docx, .doc, Rich 

Text (.rtf), or Plain Text (.txt) file, the next screen in the wizard will ask whether 

the text being imported is formatted for Multiple Choice, Term/Definition, Fact 

items, or Mixed Item Type (MS Word.docx only). Itôs important to note that only 

one type of item can be imported at a time from MS Word .doc, Rich Text .rtf or 

Text .txt formats (see the formatting requirements described below for each 

question type). To import more than one type of item to a StudyMate file use the 

MS Word .docx file, or repeat the importing process for each file of one type of 

items. 

 

When ñMS Word 2007-10 (.docx)ò is selected, a Mixed Item Types option allows 

the file to have a combination of the different item types: Multiple Choice, 

Term/Definition, and Fact items. The next screen will remind you of the 

formatting for Mixed Type Items must follow the guidelines in the online help 

and as discussed later in this section. 
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If  ñMS Word 97-2003 (.doc), Rich Text (.rtf), Text (.txt)ò is selected, the next 

screen will remind you that the text formatting for Multiple Choice, 

Term/Definition, and Fact items must follow the guidelines for the Standard 

Format, as discussed later in this section. 

 

 
 

Step 3 

The final screen of the wizard requires several actions. Click ñBrowseò to locate 

and select the file being imported.  

 

Next, indicate whether the items being imported should be appended to the 

currently open file or whether an entirely new StudyMate file should be created. If 

the second option is selected, you will additionally need to enter the name of the 

file being created. 

 

Each item being imported is given a ñtitle.ò If titles arenôt specified in the file 

being imported, StudyMate Author will create a title using the first 20 characters 

of the item wording. Alternatively, it is possible to specify ñstemò text (i.e., a 

prefix) that will then be followed by consecutive numbering starting with 001. For 

example, if you select the ñUse stem...ò checkbox and enter the text ñChapter1-ò 

the title for the first item being imported will be Chapter1-001, the title for the 

second item will be Chapter1-002, and so on. (You do not have to enter stem text-

-this feature is entirely optional.) 

 

Click the [Preview] button to preview the file being imported and to see if there 

are any warning messages. If warning messages are shown at the bottom of the 

screen, you need to decide whether to make changes to the file being imported or 

whether to continue without making changes. (Note, if a Respondus file is being 

imported, an additional window containing conversion options will appear. Select 

the desired options and click [OK] to continue.)  Be aware that some warning 

messages donôt actually require that changes be made to the file being imported. 

For instance, StudyMate Author will generate a warning message if two items 

being imported have the same title (StudyMate Author will automatically place 
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the number ñ2ò at the end of the second title to make it distinct from the first). In 

this example, if you donôt care that StudyMate Author is making a minor change 

to the title, ignore the warning message. 

 

If you are satisfied with how the results look in Preview, click [Finish]  to complete the 

import. The StudyMate file is now created or appended. Switch to the Edit menu to 

further modify the file, or go to the Preview task to view the items.   

 

Formatting a text file for importing into StudyMate Author 

 

StudyMate Author can import fact, term/definition and multiple choice questions from a 

MS Word 2007-2010 document (.docx), a MS Word 97-2003 document (.doc), a rich-text 

file (.rtf), or a text file (.txt). If using the .docx format, StudyMate Author can import a 

mix of fact, term/definition and multiple choice questions from a single document.  

Otherwise, only one type of item can be imported at a time from a MS Word .doc, Rich 

Text .rtf or Text .txt formats. The specifications for formatting the items for importing 

from a file can be found in Appendix A: The StudyMate Author Standard Format for 

Importing Items  

 

The .doc and .rtf files cannot contain images or embedded objects, such as tables. If a 

StudyMate warning indicates that the document being imported contains images or 

embedded objects, the easiest way to strip these items is to save the file to .txt format. An 

alternative is to import a MS Word 2007-2010 .docx file, a Respondus .rsp file or 

Respondus .rsa archive file with questions that contain images. However, be aware that 

other advanced elements such as multimedia may not be imported. 

 

Quick Copy Wizard 

The Quick Copy Wizard is the easiest way to select and copy items from two or more 

StudyMate files. To begin, select the Quick Copy Wizard button from the Start menu. 

The first page of the wizard provides the option of creating a new file or opening an 

existing StudyMate file and then copying items to it. Make your selection and click 

[Next]. If you selected the option to create a new file, provide a name and description of 

the file. If you selected the option to use an existing file, open the desired file as 

prompted. Click [Next] to continue.  

 

The next page of the wizard prompts you to select the StudyMate files from which the 

questions will be copied. Highlight a file and click the [Select] button. Repeat this 

process until all files from which you want to select questions are selected. Click [Next] 

to continue. 

 

The next page of the wizard prompts you to select a source file from the previous step. If 

the selected file has items that have been assigned to ñtopics,ò the list can be further 

filtered by selecting a topic from the ñShow items by topicò list.   

 

You then have the choice of using Automatic Selection or Manual Selection. When 

Automatic Selection is chosen, the available number of questions for each type of item is 
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displayed in the ñAvailable to Selectò column. In the next column, enter the number of 

questions to be selected for each type of item. When all entries are finished, click either 

the [Add to End of List]  button or the [Insert Into List]  button. Repeat this process for 

each of the source files.  

 

The Manual Selection option allows the items for each file to be viewed before making a 

selection. In fact, you can preview individual items by clicking the magnifying glass icon. 

You can also search the entire list of questions using the [Keyword Search] option at top 

right. To select questions from this list, simply click the narrow column furthest to the 

left--a mark will appear next to the question. When finished with the selections, click 

either the [Add to End of List]  button or the [Insert Into List]  button. Repeat this 

process for each source file.  

 

Note that the Automatic Selection and Manual Selection options may be combined. A file 

can also be reselected from the pull-down list and have additional items chosen from it. 

StudyMate Author will prevent you from selecting an item more than once.  

 

Once items have been added to the list at the bottom of the screen, the Difficulty values 

can be edited manually. To delete an item from the bottom list, or to move it to a different 

location in the list, click pull down the contexts menu next to the magnifying class icon 

and select the desired option. Finally, notice that a tally of the questions appears at the top 

right corner of the lower grid. 

 

The next and final page of the wizard is self-explanatory. For example, to edit items in 

the file, select the option to go to the Edit menu. To preview the activities, select that 

option, and so on.  Click [Finish]  to complete the wizard.  
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Editing a File 

Overview 

Common Features Across all Item Types 

Question List and Expanded View 

Item Types and Activities 

1) Fact 

Fact Cards 

Fact Cards+ 

2) Term/Definition 

Flash Cards 

Pick A Letter 

Fill in the Blank 

Matching 

Crosswords 

Glossary 

3) Multiple Choice 

Quiz 

Challenge 

4) Calculated  

Advanced Editing 

Adding Bold, Italics, Underline, and Super/Subscript 

Web Links 

Adding Images 

Inserting Audio 

Equation Editor 

Power Editor 

Spell Check 

Keyword Searches 

Modifying, Rearranging, and Deleting Items 

A Rapid Authoring Technique for Creating Items 

Using an Item as the Basis for a New Item 

Copying Questions from Another StudyMate File 

 

Overview of Edit Menu 

The Edit menu in StudyMate Author allows new items to be added to a file or current 

items to be edited. Four types of items can be created: Fact, Term/Definition, Multiple 

Choice and Calculated. Up to ten activities can be created from these items. 
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Common Features Across All Item Types 

Four types of items can be created with StudyMate Author: Fact, Term/Definition, 

Multiple Choice, and Calculated. To create a new item, select the desired type from the 

left side of the screen. The entry form to its right will change accordingly; the activities 

that can be generated from that type of item are also listed. 

 

Each item allows the entry of a ñTitle.ò A title can be up to 60 characters. If you do not 

enter a title, StudyMate Author will use the first 20 characters from the next data entry 

field.  

 

Two optional features are available with each edit form: Difficulty level and Topic. The 

Difficulty level can be set between 1 and 5 (1=Low, 5=High). Items can also be assigned 

to a Topic, either an existing one or a newly created one. The small buttons located to the 

right of the Difficulty and Topic options determine whether an entry for that item is 

required. If the asterisk is selected, it becomes a required entry field.   

 

Four buttons appear at the bottom of all edit forms. The [Add to End of List]  button adds 

the current item to the end of the ñItem Listò (located at the bottom of the screen). Use 

[Insert Into List]  to insert the current item to a specific position in the Item List. 

The [Clear Form]  button will erase all data that currently shows in the form. Finally, the 

[Preview] button opens a browser-like window that shows how the item will appear 

when exported as an activity. The Preview window, which can be selected at any stage in 

the editing process, includes a pull-down list at top that allows a different activity or 

game to be previewed.  
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Question List and Expanded View 

At the bottom of the Edit menu, the ñItem Listò displays the title, format, topic, difficulty 

and wording for each item in the file. The first column enables you to preview an item by 

clicking the magnifying glass icon.  The context menu in the next column will display a 

pop-up dialog with various operations that can be performed on that item. 

 

 
 

The context menu offers the following operations: 

 

Preview ï Preview the item. 

Edit  ï Edit the item. 

Delete ï Delete the item. 

Move to # - Move the question to a new location in the list. 

Use As Basis For New Item ï Open the item in the edit template and use it as the basis 

for a new item.  The original title will be modified slightly ï for example, the number ñ2ò 

will be added to the end of the name. 

Copy Items From Another File ï Items can be selected and copied from another 

StudyMate file into the current file. 

Properties ï Displays a window that summarizes the properties for the item. 

 

The [Expanded View] button, located at the top right of the Question List, displays a full 

screen pop-up of the question list. This enables you to view more items at once. 
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Item Types and Activities 

There are four types of items in StudyMate Author (Fact, Term/Definition, Multiple 

Choice, and Calculated). Several games and activities can be generated from each type of 

item. These are described below. 

 

1) Fact 

Use a Fact item to enter a fact, statement, or any text that doesnôt have a precise answer. 

The following fact is an example of a Fact item: 

 

  Albert Michelson determined the speed of light in 1879. 

 

The StudyMate Author activities that can be created with Fact items include Fact Cards 

and Fact Cards+.  
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Fact Cards 

Fact Cards are one-sided cards that display text on them. 

 

  
 

Click Next or Previous to scroll through the cards. Shuffle will randomize the deck of 

cards and Reset will return you to the first card in the deck.  

 

Fact Cards+ 

Fact Cards+  is identical to Fact Cards except that it additionally sorts the cards into 

topics. The topics are then displayed along the left side of the activity. An item can be 

assigned to a topic during the editing or import steps. 

 

  
 

2) Term/Definition  

A Term/Definition item has a word/phrase that is associated with another word/phrase. A 

common example is a glossary ñtermò that has an associated ñdefinition.ò Another 

example is a fill-in-the-blank ñquestionò that has a specific word or phrase for the 

ñanswer.ò  
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 Example:  

  

  Term or Answer: Albert Einstein 

  Definition or Question: Developed the General Theory of Relativity 

 

The StudyMate Author activities that can be created with Term/Definition items include 

Flash Cards, Pick a Letter, Fill in the Blank, Matching, Crosswords, and Glossary. 

 

Flash Cards 

Flash Cards are two-sided cards that display the term/answer on one side of the card and 

the definition/question on the second side of the card.  

 

  
 

Click Flip Card to see the second side of the card. Select Next or Previous to scroll 

through the deck of cards. Shuffle randomizes the deck of cards and Reset returns you to 

the first card in the deck. The Display Other Side First option determines which side of 

the card is shown first.  
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Pick a Letter 

Pick a Letter displays the definition/question at the top of the screen and has the user type 

or click the letters contained in the answer. If a letter appears more than once in an 

answer, all uses of that letter will be displayed when it is selected.   

 

 

  
 

If an incorrect letter is entered, 1 point (of a possible 5 points) is deducted for that 

question. A user can continue answering the question even after the point value reaches 

zero. 

 

Next Question proceeds to the next question in the list; no points are awarded if the 

answer isnôt completed before clicking Next Question. Hint reveals the next letter or 

character in the answer; one point is deducted for each hint until the point value for the 
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item reaches zero. Show Answer reveals the entire answer; no points are awarded when 

this option is used. Reset starts the activity over again. 

 

Once the final item is answered, a score will be displayed.  

 

Fill In the Blank 

Fill in the Blank displays the definition/question in the top section and has the user enter 

the exact term/definition for the answer. If the answer isnôt exactly correct, StudyMate 

provides a hint based on the text entered in the previous attempt. One point (of a possible 

5 points) is deducted for each incorrect attempt. There is no limit to the number of 

attempts allowed, even if the point value for the item reaches 0.  

 

  
 

Next Question moves you to the next question in the list; no points are awarded if the 

answer isnôt completed before clicking Next Question. Hint reveals the next letter or 

number in the answer; one point is deducted for each hint until the point value for the 

item reaches zero. Show Answer reveals the complete answer; no points are awarded 

when this option is used. Reset starts the activity over again. 

 

Once the final item has been answered, a score will be displayed.  

 

Matching 

The Matching activity displays the definition/question in the top section and has the user 

select from one of the nine term/answer windows below. The answer windows donôt 

change until six correct answers have been revealed. At that time the nine answer 

windows are repopulated and the sequence repeats itself. 

 

Itôs important to understand that the contents of the nine answer windows are randomly 

drawn from other items in the file. This works well if all Term/Definition items in the file 

are similar (eg. all items are persons, or all items are events, or all are definitions). 

However, if the Term/Definition items are a mixture of topics it may be desirable to 

exclude the Matching activity when generating the activities.  
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There must be at least 9 Term/Definition items in a file before StudyMate will allow the 

Matching activity to be created. 

 

Next Question moves you to the next question in the list; no points are awarded if the 

prior item isnôt answered before clicking Next Question. Show Answer reveals the answer 

for the item; no points are awarded when this option is used. Reset starts the activity over 

again. 

 

Crosswords 

A Crossword puzzle displays the ñclueò (i.e. the definition or question) at the bottom of 

the screen and requires the user to enter the ñanswerò in a corresponding, highlighted area 

of the grid. Answers are entered one letter at a time and itôs possible to switch to another 

clue before supplying any or all letters for the answer. Tallies for ñcorrectò and ñmissedò 

letters are provided, with the possibility of multiple misses occurring for a single square.  

 

Play begins by clicking a white, unanswered square. A highlight appears around all letter-

boxes that comprise the answer, while the clue for the item is displayed at the bottom of 

the screen. The user can select a letter from the keyboard or from the palette of characters 

on the right side of the screen. International characters or numbers can be selected from 

the palette by first clicking the ñ>>>ò button to reveal additional items. A puzzle is 

complete when all letter boxes have been solved. 
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ñReveal Letterò displays the letter for the highlighted square and increases the ñMissedò 

tally by one. ñSolve Puzzleò reveals all remaining letters for the puzzle; no changes occur 

to the ñCorrectò or ñMissedò tallies. The ñNext Puzzleò button, when displayed, clears 

the current puzzle and skips to the next round (if one is available). The ñCorrectò or 

ñMissedò tallies are unchanged when Next Puzzle is clicked.   

 

ñResetò refreshes the screen, clears the tallies, and starts the first puzzle again. Puzzles 

are not recompiled when the Reset button is clicked, just started again. 

 

If an answer has multiple words (ñICE AGEò), the blank space between words will be 

eliminated (ñICEAGEò). Special characters ($, %, #) and punctuation ( - ,?) are revealed 

at the start of a puzzle.  

 

When publishing the Crossword activity to StudyMate.com, the puzzles are created each 

time a student accesses the activity. Different students will be presented with different 

puzzles each time. 

 

When exporting as Adobe Flash module or a SCORM module, the puzzles are compiled 

in the StudyMate Author authoring tool, before they are exported to Adobe Flash format. 

Thus, a crossword puzzle will be the same each time a student uses it.  

 

The Crosswords activity in StudyMate draws its data from the ñTerm/Definitionò 

template. Only those terms/answers that have 15 or fewer characters will be used during 

the compilation of a puzzle. If the StudyMate file has more than about a dozen 

ñTerm/Definitionò items, it can generate multiple puzzles (or ñroundsò) from the 

available data. The Settings menu StudyMate Author lets the instructor specify the 

maximum number of rounds permitted for a puzzle, ranging from 1 to 10.  

 

The Settings menu also allows the instructor to control when crossword puzzles are 

compiled, which can take up to 4 seconds per puzzle round. The compilation time is 

dependent on how many ñTerm/Definitionò items are contained in the file and how many 

puzzle rounds are being permitted (a Setting option). Another setting determines whether 

a puzzle is compiled each time the Preview task is selected in StudyMate Author or only 

if a change has been made to the StudyMate file.  
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Glossary 

The Glossary tool provides an alphabetic listing of all Term/Definition items in the file. 

The term/answer is presented first, immediately followed by the definition/answer. Click 

a letter at the top of the screen to list the terms that start with that letter. The ñotherò 

category listed at the end of the alphabet will display terms that start with numbers, 

punctuation or special characters. The ñAllò option will list all Term/Definition items in 

the file alphabetically. To locate a glossary item that contains a particular word or phrase, 

use the Search feature.  

 

  
  

Note that it may be necessary to exclude the Glossary activity when generating the 

activities if the Term/Definition items donôt use a ñterm-definitionò approach. For 

example, if the Term/Definition items are math problems in which the answer is a 

number, they wonôt make a very useful glossary.  

 

 

3) Multiple Choice 

A Multiple Choice item displays a question, followed by a list with one correct answer 

and several distracters.   

 

 

Example: 

3) Who determined the exact speed of light? 

 

a. Albert Einstein 

b. Albert Michelson 

c. Thomas Edison 

d. Guglielmo Marconi 

 

Answer ñfeedbackò can be included with Multiple Choice questions so that students can 

view additional information about the answer. For example, the following feedback 
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might be displayed after a student answers the above question (regardless of whether the 

correct or incorrect answer was submitted): 

 

Albert Michelson was the first American to win the Nobel Prize in Physics 

(1907) for his measurements of the speed of light. His experiments laid the 

groundwork for Einsteinôs Theory of Relativity. 

 

To add feedback to a Multiple Choice question, click the [Feedback] button to open an 

editing window. When the feedback text has been entered, click the [X] at the top right 

corner of the feedback window to close it.  

 

Itôs possible to have the answer choices (distracters) displayed in random order for a 

question. Simply select the ñrandomizeò box.  

 

The following StudyMate Author activities can be created with Multiple Choice items: 

Quiz and Challenge. 

 

Quiz 

A Quiz will show one multiple choice question at a time. The question wording is 

presented at the top of the screen with the answer choices shown below it. The correct 

answer is selected by clicking on the letter that represents it. 

 

  
 

After an answer is selected, the ñNext Questionò button will flash and stay highlighted. If 

feedback is set to display immediately after a question is answered (see the ñSettingsò 

section below), the screen will indicate whether the answer is correct or wrong and will 

display any feedback entered for that question.   

 

Reset starts the quiz again without any changes to the quiz itself. Shuffle also starts the 

quiz again but additionally randomizes and/or reselects the questions from a larger set of 

questions (again, depending on the ñSettingsò that have been selected).  
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Upon completion of the Quiz activity, a score will be presented. The user will have a 

chance to review the incorrectly answered questions at this point.  

 

Challenge 

Challenge presents multiple choice questions in a fun, game-show environment. The 

game board consists of 5 topics, where each topic has 5 questions with point values that 

range from 100 to 500.  

 

  
 

At the start of the Challenge game, select the ñOne Playerò or ñTwo Playerò option. The 

Two Player mode additionally allows names to be entered for the players or teams.  

 

The game is started by clicking one of the point values below a topic. The question and 

answer choices are listed in the box below. The correct answer is selected by clicking on 

the letter that represents it. Players are immediately shown whether the answer is correct 

or wrong. If the answer selection is wrong, the correct answer will be displayed in green 

text and the incorrect answer will appear in red. If feedback is available for the question, 

it too will be displayed at this time. 

 

Challenge makes use of the ñDifficultyò option that is available when multiple choice 

questions are created or imported with StudyMate Author. Questions will be distributed 

within a topic according to its original difficulty weighting (1=low, 5=high). Questions 

that donôt have a difficulty level assigned to it are treated as a ñ3ò in terms of difficulty. If 

there arenôt enough questions within the various levels of difficulty, StudyMate Author 

will distribute the questions the best that it can.  

 

Challenge also uses the ñTopicsò option that is available when questions are created or 

imported with StudyMate Author. Questions that havenôt been assigned to a topic will be 

displayed under a ñMixed Topicsò heading during the Challenge game. A minimum of 5 

topics with at least 5 items each is recommended to avoid ñMixed Topicsò headings. 
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The point value indicated when a question is selected will be applied to the playerôs total 

score for the game. If the player answers the question correctly, the ñtotal scoreò will 

increase by that amount. Conversely, if the answer is answered incorrectly, the score will 

be reduced by that amount. Negative scores are very much possible! 

 

Show Answer will immediately display the correct answer to the question. Only 100 

points are deducted if the Show Answer option is used. Thus, a ñwild guessò may not be 

the best strategy when playing against another partner or team since the penalty for using 

Show Answer may be less.  

 

4) Calculated
1
 

Calculated items require students to apply a mathematical formula to answer the 

question. Calculated items are designed using variables. Random values, based on a 

specified range, are automatically generated for each variable in the question. Thus, 

Calculated items can be unique for each student, as illustrated in this example where 

values are inserted for {x} and {y}.  

 

Example: If a car is traveling {x} miles per hour for {y} hours, how far does it 

travel (in miles)?  

 

The following StudyMate Author activities can be created with Calculated Choice items: 

Quiz and Challenge. 

 

The StudyMate editor for Calculated items requires that the following sections be 

completed: 

 

 Question Wording 

 Formula 

 Variable Properties 

 Answer Properties 

 Value/Answer Sets 

 

Calculated ï Question Wording 

In the Question Wording section, enter the text of the question just as you would for any 

other question type. However, instead of using specific numerical values to define the 

details of the question, instead use variables by specifying a name enclosed in curly 

brackets for each one. For example: ñHow long does it take to travel {x} miles at a speed 

of {y} mph?ò 

 

Variable names can only contain letters and digits (the characters 0-9, a-z, and A-Z), and 

the ñ_ò (underscore) character. However, the first character of a variable name cannot be 

a number and the variable names ñeò and ñpiò should not be used. 

                                                 
1
 Calculated questions are not currently supported with StudyMate.com activities. 
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You can use as many different variables as you need to define the question, and you can 

use the same variable name multiple times if necessary. 

 

Calculated - Formula 

In the Formula section, enter the mathematical formula associated with the question. This 

is the same formula that the student will be expected to use, and the same one that will be 

used to automatically calculate the correct answer for grading purposes. The same 

variables specified in the question wording will be used to indicate where each value 

should go in the formula. 

 

The formula can be typed into the edit field directly, or entered by selecting options from 

the pull-down lists provided for Variables, Functions, Operators, and Constants. Selected 

options will appear in the edit field at the current cursor location, and will overwrite the 

current selection (if any). 

 

The ñVariablesò list provides an easy way to select a common variable name. 

 

The ñFunctionsò list provides the following supported mathematical functions: 

 

abs(x)  Absolute value of x. abs(-3) = 3. 

acos(x) Arc-cosine of x in radians 

acosh(x) Hyperbolic arc-cosine of x in radians 

angle(x,y) Arc-tangent of x/y in radians. Uses signs to determine result 

quadrant. 

asin(x)  Arc-sine of x in radians 

asinh(x) Hyperbolic arc-sine of x in radians 

atan(x) Arc-tangent of x in radians 

atan2(x,y) Same as angle(x,y) 

atanh(x) Hyperbolic arc-tangent of x in radians 

ceil(x)  Round x up to the nearest integer. ceil(2.1) = 3. ceil( -2.1) = -2. 

cos(x)  Cosine of x in radians 

cosh(x) Hyperbolic cosine of x in radians 

exp(x)  Base e (Eulerôs constant) raised to the power of x 

fact(x)  Factorial of x. fact(3) = 6. 

floor(x)  Round x down to nearest integer. floor(2.8) = 2. floor(-2.8) = -3. 

int(x)   Return integer portion of x. int(4.32) = 4. int(-4.32) = -4. 

ln(x)  Base e natural logarithm of x 

log(x)  Same as ln(x) 

log10(x) Base 10 logarithm of x 

max(x,y,é) Return the maximum of all supplied arguments. max(1,2,3) = 3. 

min(x,y,é) Return the minimum of all supplied arguments. min(1,2,3) = 1. 

mod(x,y) Modulus or remainder of x/y. mod(5,2) = 1. 

rand()  Return a random number between 0 and 1 

round(d,x) Round x to d decimal places. Halfway cases round away from 0. 

sin(x)  Sine of x in radians 

sinh(x)  Hyperbolic sine of x in radians 
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sqrt(x)  Square root. sqrt(9) = 3. 

sum(x,y,...) Return the sum of all supplied arguments. sum(1,2,3) = 6. 

tan(x)  Tangent of x in radians 

tanh(x) Hyperbolic tangent of x in radians 

 

Note that the values for trigonometric functions are expressed in radians, not degrees. For 

conversion purposes, Pi radians = 180 degrees. Also, for all formulas that have two 

correct answers (for example, the square root of 9 is +3 and -3), only the positive number 

will be treated as correct. 

 

After selecting a function from the list, the formula must be edited to replace the 

argument list with numbers or variables. For example, ñround(d,x)ò might be edited to 

specify a fixed number of decimal places and a variable to round, as in ñround(3,{y})ò, 

which would round the variable {y} to 3 decimal places. 

 

Functions can also be nested within a formula, as in ñsqrt(abs({x}))ò. In this case, the 

absolute value of {x} is evaluated first, followed by the square root of the result. 

Functions can be nested as deeply as necessary to properly calculate the answer. 

 

When entering numerical values, scientific notation is expressed in the format xEy, where 

x is the coefficient and y is the exponent. To convert numbers from scientific notation to 

standard notation, use x times 10 to the power of y. For example: 

 

 3.2E4 equals 32000 

 -2E0 equals -2 

 3.14E-2 equals 0.0314 

 

The ñOperatorsò list provides the following standard mathematical operators: 

 

- Subtraction 

() Parentheses used to group elements for precedence 

*  Multiplication 

**  Power or exponent. For example, 2**3 = 8. 

/ Division 

+ Addition 

 

The ñConstantsò list provides the following commonly-used numerical constants: 

 

_e Base e or Eulerôs constant (2.71828é) 

_pi Pi ï the circle ratio (3.14159é) 

 

Some example questions and associated formulas might be: 

 

Question: How long does it take to travel {x} miles at a speed of {y} mph? 

Formula:  {x}/{y}  
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Question: What is the positive square root of {x}? 

Formula:  sqrt({x})  

 

Question: Compute sin(x) where x = {x} degrees. 

Formula:  sin({x}/180*_pi) 

 

Calculated - Variable Properties 

Clicking the ñVariable Propertiesò button in the Formula section displays the Variable 

Properties dialog. Here, each variable in the question wording and formula is listed by 

name, along with Minimum, Maximum, and Scale values for that variable. 

 

The Minimum and Maximum define the range of values each variable can be assigned, 

and the Scale specifies the number of decimal places each value should be allowed before 

the value is rounded off. 

 

You can click each cell in the grid to edit the specific minimum, maximum, or scale value 

you want to change (the variable names cannot be edited). In general, for a given variable 

the minimum must be less than or equal to the maximum, and the scale must be greater 

than or equal to 0 and less than or equal to 5. 

 

Calculated - Answer Properties 

Clicking the ñAnswer Propertiesò button in the Formula section displays the Answer 

Properties dialog. Here you can specify values for answer scale and acceptable tolerance, 

as well as a unit name if required. 

 

Answer scale can be specified in Decimal Places. If the answer scale is specified in 

decimal places, the value must be greater than or equal to 0 and less than or equal to 5, 

just as with the scale values specified in the Variable Properties dialog.  

 

Answer tolerance is the amount that the studentôs answer can deviate from the calculated 

answer and still be considered correct. It can be specified as a numeric value or as a 

percentage of the answer value. 

 

If you choose to require a unit name, comparisons with the name entered by the student 

will be case-insensitive and space-insensitive. 

 

Calculated - Value/Answer Sets 

Clicking the ñValue/Answer Setsò button below the Formula section displays the 

Value/Answer Sets dialog. Here you can generate sets of variable values and calculate the 

associated answers using the formula previously entered. When the Calculated item is 

presented to the student, one of these value sets will be randomly chosen to populate the 

variables in the question wording and the formula, and the associated answer will be used 

to grade the studentôs response. 

 

The grid displays a list of numbered value/answer sets. The number of sets available can 

be selected from the ñNumber of Setsò pull-down list. If images or equations are included 
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in the question wording, a maximum of only 10 sets can be selected. The contents of this 

list will vary, depending upon the complexity of the question wording. For each set, the 

generated values for each variable are shown, and the individual cells can be clicked to 

edit those values. Note that any manually-entered values must be within the range 

specified by the variable minimum and maximum in the Variable Properties dialog. The 

answers cannot be edited; instead, the ñUpdate Answersò button can be clicked to 

recalculate the answers for all value sets.  

 

Feedback 

Answer ñfeedbackò can be included with Calculated item so that students can view 

additional information about the answer. For a Calculated item however, the feedback 

would need to be very generic due to the multiple value/answer sets.   

 

To add feedback to a Calculated item, click the [Feedback] button to open an editing 

window. When the feedback text has been entered, click the [X] at the top right corner of 

the feedback window to close it.  

 

Advanced Editing 

 

Adding Bold, Italics, Underline, and Super/Subscript 

StudyMate Author makes it possible to add bold, italic, and underline to words. Simply 

highlight the text you want to modify and click the appropriate [B], [I ], or [U] button on 

the tool bar. The text will immediately change to the selected formatting. The superscript 

[X
2
] and subscript [X2] tools function in the same manner. To remove the formatting, 

highlight the text again and reselect the corresponding button from the toolbar.   Caution 

should be used when using formatting other than bold, italic, and underline in Calculated 

items. When advanced formatting (subscripts/superscripts, images and the equation 

editor) is used in Calculated item and the activity is exported as an Adobe Flash module, 

StudyMate Author must store each variation of the problem as an image instead of as text 

data, which greatly increases the size of the published Flash object. 

 

 

Web Links 

The Web Links tool on the toolbar lets you add a link to a website or to a file that is 

located on another web server. A new browser window will open when the user clicks on 

the web link from within the activity.  

 

To create a web link, select the Web Link icon from the StudyMate Author toolbar and 

then follow the instructions for adding a web link. A link to a specific web page can be 

created, or you can create a link to a media file that resides on another server. In both 

cases, you will be prompted to enter the text that is to be displayed for the link itself.  

 

A Web Link cannot be used if a text field already has advanced formatting, such as 

images, equations, tables, super/subscript. Similarly, if a text field has a Web Link, youôll 

be prevented from adding advanced formatting, such as images and equations. 
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Adding Images 

Images can be added to most text fields in StudyMate Author. When exporting as an 

Adobe Flash module, images should be used sparingly because they can significantly 

increase the size of the Flash object.  

 

From the Edit menu, position the cursor in the text field where you want the image to be 

added. Then click the ñInsert imageò icon on the toolbar, which is represented by a 

camera. A pop-up window will let you navigate to and select the image, provided that it 

is in one of these formats: bmp, gif, jpeg, png, pcx, and emf. 

 

After selecting an image, the following window appears: 

 

 
 

If the image is over 400 x 300 pixels, StudyMate Author will reduce it to the required 

size. An image can be made even smaller by manually adjusting the value for the ñScale 

toò field.   

 

Alternate text for images can be entered in the field provided. ALT text for accessibility 

is supported when activities are published to StudyMate.com. For activities exported as 

Adobe Flash modules, ALT text is not supported in the Flash objects.  

 

Click [OK] to close the window and return to the Edit menu. You will now see a set of 

green characters like <PIC_1> that represents the image. Be sure to preview all images 

prior to saving the item to the file. This will assure that the image size and position is as 

intended.  

 

To delete an image, position the cursor in the same field where the item is located. Then 

click the ñInsert Imageò icon on the toolbar (the camera icon) and select the option to 

delete an existing image or file. 

 

Itôs important to understand that images can significantly increase the size of the final 

activities files, particularly if high-color photos and images are used. A high-color image 
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may be three times the size of a similar image that uses 256 colors. Also keep in mind 

when exporting activities as Adobe Flash modules that they work differently than the 

HTML5-based activities published to StudyMate.com.  Unlike HTML-based web pages, 

a Flash object must be fully downloaded before anything can be viewed.  

 

If a large number of images will be contained in a StudyMate file, consider optimizing 

the images to a "web-friendly" format and size. Save screen captures and similar complex 

image files in PNG format and save photos in JPG format instead of BMP. Simple line 

art and similar clip art are best saved as GIF files. 

 

Also reduce the overall pixel size of the image. Currently, 800 x 600 pixel resolution is 

an acceptable image size. Note that some image editors will only shrink the "viewable" 

size of the image while still retaining the original pixel resolution and file size. Verify the 

image has actually been reduced in pixel resolution before adding to a StudyMate item. 

 

The Preview task available from the ñPreview & Publishò menu displays the overall size 

of the Flash object if Export as Adobe Flash module will be used. This will help you 

determine whether a StudyMate activities file is becoming too large. 

 

 

Inserting Audio 

The Insert Audio tool allows for audio to be embedded directly into StudyMate activities.  

This feature should be used sparingly since audio files can use large amounts of space 

and can significantly increase the size of the final StudyMate activity file. (Consider 

placing larger audio files on a separate server and using the Web Link tool in StudyMate 

Author instead.) 

 

To embed an audio file, from the Edit menu, position the cursor in the text field where 

you want the link for the embedded audio file to appear.  Click the ñInsert audioò icon on 

the toolbar, which is represented by a musical note surrounded by sound waves.  The 

following pop window will appear:  

 



34 

 

 
 

First, indicate the audio format of the file being selected, MP3 or WAV.  MP3 formats 

are preferable as they usually maintain quality with a smaller file size.  Both WAV and 

MP3 files can be created easily on a computer with a microphone or headset using many 

readily available audio recording programs such as Audacity 

(http://audacity.sourceforge.net). Many digital audio recorders also record in both WAV 

and MP3 format. 

 

Next, choose the [Browse] button to browse to a location on your hard drive to where the 

Audio file is located. Once a file is selected, click [Open].  MP3 files cannot be altered 

(sampled) within StudyMate Author; instead they must be encoded properly during the 

recording process or with audio editing programs.  However, compression quality and 

size can be selected for uncompressed WAV files which can be stored as 8-bit mono with 

a sample rate of 5.5, 11, or 22 KHz.  Higher sample rates increase the quality but use 

much more space and create a much larger StudyMate activities file. If audio quality is 

important consider converting to the MP3 file format prior to adding to a StudyMate item 

or use the Web Link tool to link to a high quality audio file on another web server. 

 

The overall size of a StudyMate activity can be determined within StudyMate Author by 

going to the >Preview & Publish Tab > Preview >Preview the File.  At the bottom of the 

preview window itself, a number will be displayed, such as "Flash object size = 168 K".  

It is important to note that a file size of 480 K will require about 2 minutes downloading 

using low bandwidth connections but often less than 10 seconds using a high speed 

bandwidth connection. 

 

http://audacity.sourceforge.net/
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The next step is to enter the text for the link that the user will click to hear the audio file.  

The audio file can be previewed if desired.  If satisfactory, choose [Finish] to complete 

the embedding of the audio file. 

 

When using audio files with other advanced formatting features (subscripts/superscripts, 

the equation editor, images, and web links) it is important to understand that StudyMate 

stores the wording for a question or answer choice as an image and not text data.  In this 

situation, the link for the audio clip will appear after the question text, and the phrase 

"[clip 1 below]" will appear in place of the text for the link. .   

 

 

Equation Editor 

The process of adding equations is similar to how images are added. From the Edit menu, 

position the cursor at the place in the text where the equation is wanted. Then click the 

ñEquation Editorò button on the toolbar, which is represented by a summation symbol. 

The Equation Editor will open and you can begin creating the equation. The Equation 

Editor in Respondus works almost identically to the one that is available with Microsoft 

Word and many learning management systems. So if youôve used those equation editors, 

youôll already know how to use this one. A key thing to learn about the Equation Editor is 

that the top row consists of ñsymbolsò while the bottom row consists of ñpalettesò. If you 

select a ñsymbolò from the top row, itôs no different than if you selected the + or = sign 

on your keyboard -- except that the symbols from the Equation Editor eventually get 

displayed as graphics. When a ñpaletteò is selected from the bottom row, text can be 

entered at various insertion points. Itôs also possible to select a palette from the bottom 

row, click in an insertion point, and then select a symbol from the top row. For more 

information about the Equation Editor, refer to the online help that is available from 

within the editor.  

 

When finished editing the equation, exit the Equation Editor by either clicking the [X] 

that appears at the top right corner of the window or by selecting File from the menu bar 

and clicking Exit (do not simply minimize the Equation Editor). A new window appears 

that allows you to adjust the scaling of the equation. To accept the default setting of 

150%, simply click [OK].  

 

Al ternate text for equation images can be entered in the field provided. ALT text for 

accessibility is supported when activities are published to StudyMate.com. For activities 

with equation images exported as Adobe Flash modules, ALT text is not supported in the 

Flash objects. 

 

Once an equation has been added and you return to the Edit menu, you will see a set of 

green characters like <EQ_1> that represents the equation image. Be sure to preview all 

equations prior to saving the item to the file. This will assure that the image size and 

position is as intended.  
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To modify or delete an equation, position the cursor in the same field where the equation 

is located. Then click the Equation Editor icon on the toolbar and select the option to 

modify or delete an existing equation.  

 

 

Using MathType with StudyMate Author 

 

The Equation Editor in StudyMate Author is a special version of MathType
TM

 by Design 

Science. If you frequently create documents with equations, you may find MathType is 

better suited to your needs. MathType is as easy to use as the Equation Editor and has 

many extra features to help you save time and create a wider range of equations.  

 

For further information about purchasing MathType, contact your software dealer or 

Design Science directly: Design Science, Inc., 140 Pine Avenue, Long Beach, CA 90802, 

USA.  

 

 Toll free: 800-827-0685     International: 562-432-2920 

 Fax: 562-432-2857 

 Email: sales@dessci.com 

 Web: http://www.dessci.com 

 

If you already own MathType, you will need to reinstall it in order to have it work 

directly with StudyMate Author. MathType's readme file explains that it sets itself up to 

replace Equation Editor at the time that it's installed. So if you add a new application like 

StudyMate Author that uses the Equation Editor, you must re-install MathType. 

 

Power Edit 

The ñPower Editò task available from the Edit menu provides a table editor and a larger 

workspace for editing large blocks of text. 

 

Click in the field that you want to edit and then click the ñPower Editò button on the 

toolbar. Most tasks on the Power Edit toolbar also appear on the main toolbar. Only the 

Table editor is unique.  

 

Tables 

StudyMate Author makes it possible to insert and edit simple tables. From the Edit menu 

in StudyMate Author, position the cursor at the location where you want to insert the 

table. Then click the ñPower Editò button and select the ñInsert Tableò icon from the 

toolbar. When the next pop-up window appears, specify the number of columns and rows 

that should be included in the table. Click the [OK] button to return to the Power Edit 

window. You can now click within the cells of the table and enter the text.  

 

The width of the table cells can be adjusted by dragging the column lines. To edit other 

aspects of the table from the Power Edit menu, click within the table and select the 

desired action from the pull-down menu labeled ñTable.ò Use the ñInsertò option to add a 
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row or column to the table. Use the ñDeleteò option to delete a row or column, or to 

delete the entire table.  

 

Finally, keep in mind when exporting as an Adobe Flash module that tables will 

eventually be turned into graphics so that they can be displayed in the Flash object. So 

use tables sparingly since they will increase the overall size of the Flash object. 

 

 

Spell Check 

The Spell Check feature, which is located on the toolbar for the Edit menu, will search 

the currently open file for spelling errors and allow corrections to be made. Once the 

Spell Check feature is started, it will search for words that do not match items stored in 

the dictionary. If the word is not found in the dictionary, you are given the option to 

ñChangeò the word to one that is suggested, to ñIgnoreò the identified word, to ñChange 

Allò such words in the file to one you select, or to ñAddò the word to the dictionary. If 

you want to make more detailed changes to the question, click the ñEdit This Questionò 

button, which will close the spell checker and make the question available for editing.  

 

Three dictionaries are included with a standard installation of StudyMate Author: 

American English, Canadian English, and British English. However, a free bundle of 

supplemental dictionaries can be downloaded from the Respondus website, including 

French, German, Spanish, Dutch, Finnish, and a comprehensive medical dictionary. 

 

Keyword Searches 

There are several places in StudyMate Author where the [Advanced Search] or 

[Keywoard Search] button appears, such as at the bottom of the Edit menu, at the top of 

the Expanded View and in the Quick Copy Wizard. Keyword searches are also available 

with [Search] in the ñOpen StudyMate Fileò dialog when a file is being opened. This 

option allows you to search the currently open file or the file that is being previewed.  

 

Up to three words can be included in a search. When more than one word is used, you 

can choose whether a match is required of all words or any of the words. The search can 

be further filtered by selecting a topic from the pull-down list (if the items have been 

assigned to a topic). A final option allows answer choices and feedback to be included in 

the search.  

 

 

Modifying, Rearranging, and Deleting Items 

It is easy to modify, move, or delete an item in StudyMate Author. From the Edit menu, 

pull down the context menu next to an item in the ñItem Listò Select Edit  to modify the 

item, Delete to delete the item and Move to place the item at a different position in the 

Item List. If you select the Edit  button, you will be returned to the Edit screen and the 

current properties for that item will be displayed in the form--modify the item as you like. 

When modifying an item, notice that the two buttons at the bottom of the form now 

indicate ñSave Changesò or ñCancel Changesò. If you want to save the changes to the 
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item, select the corresponding button. If you donôt want the changes to be implemented, 

select [Cancel Changes].  

 

A Rapid Authoring Technique for Creating Items  

If you plan to use the same basic content across the Multiple Choice, Term/Definition, 

and Fact templates, the following rapid authoring technique can be employed. 

 

Starting with the Multiple Choice template, complete the fields as normal.  Before adding 

the item to the list, click the checkbox "After saving this item, use it to create a 

"Term/Definition" item".  The Multiple Choice item will be saved and StudyMate Author 

will automatically switch to the Term/Definition template. The Term/Definition template 

will be populated with text from the previously entered Multiple Choice item, but make 

sure the wording makes sense for the new Term/Definition item being created. Before 

adding the new Term/Definition item to the item list, select the checkbox "After saving 

this item, use it to create a "Fact" item". Once the Term/Definition item has been saved, 

StudyMate Author will now switch to the Fact template and populate it with the same 

text. Again, make sure the wording for the new Fact item makes sense and then add it to 

the list.    

 

This rapid authoring technique sometimes requires that text be adjusted along the way.  

For example if a Multiple Choice item has a correct answer of "All of the Above", the 

text that will populate the Term/Definition template will not make sense unless you 

modify the "Term or Answer" field. 

 

 

Using an Item as the Basis for a New Item 

To use an existing item as the starting point for a new item, locate the original item in the 

ñItem Listò at the bottom of the Edit menu. Pull down the context menu next to an item in 

the ñItem Listò and select Use as Basis for New Item. You will be returned to the Edit 

screen and the properties for the original item will be displayed in the form. The original 

title for the item will be modified slightly--for example, the number ñ2ò will be added to 

the end of it. At this point you can rename the title and make any other changes you like. 

When finished, add or insert the item to the Item List.  

 

 

Copying Items from Another StudyMate Author File 

From the Edit menu it is possible to copy items from another StudyMate Author file. Pull 

down the context menu next to any item in the ñItem Listò and select Copy from 

another file. This will open a window containing the files stored in the default directory 

(\StudyMate Projects). Select a ñsourceò file by double-clicking the file name or by 

clicking it once and selecting [Open].  

 

Tip:  Before selecting a file, you can search the contents of the file by clicking on 

it once and then clicking the [Search] button. You can also view the items in a 

file -- prior to opening it -- by highlighting the file name and clicking the ñItem 
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Listò button.  A specific item can be previewed by clicking the magnifying glass 

icon. 

 

Once the source file is selected, a new window lists the items contained in it. An item can 

be selected by clicking the column furthest to the left. A checkmark will indicate that the 

item has been selected. When all the desired items have been selected, choose either the 

[Add to End of List]  button or the [Insert into List]  button to add the items to the 

currently open file between existing items in the ñItem Listò.  
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Settings Menu 

 Overview of Settings Menu 

 Settings for Item Types 

 Other Settings 

  - Color Settings template 

  - Accessibility Support 

  - Language Settings 

  

 

Overview of Settings Menu 

The Settings Menu allows you to specify settings for each activity. There is a settings tab 

for the each item type (Fact, Term/Definition, and Multiple Choice/Calculated). The 

Other Settings tab allows you to select color settings, ñaccessibilityò settings, and the 

language in which the interface for the StudyMate activities will appear (English, French, 

German, etc.).  

 

Settings for Item Types 

Each StudyMate activity, except for Glossary and Challenge, has a setting that 

determines whether all items available for it will be displayed during each user session. 

The alternative is to display a subset of the available items during user sessions. For 

example, letôs say that the file contains 100 items that can be used with the ñPick A 

Letterò activity. Instead of including all 100 items each time the activity is played, you 

may prefer that 25 items be randomly selected each time. To do so, choose the ñSelect a 

fixed numberò option and enter the number 25. (To clarify this example, all 100 items 

would be contained in the StudyMate file, but only 25 would be selected each time a 

student started the activity.) If you choose the option to have all items displayed during 

each user session, you have the choice of having the items delivered in random order or 

in the order that they appear in the StudyMate file. 

 

Additional settings are available for the Quiz activity. To have feedback shown 

immediately after an answer is provided by the student, select the option ñShow feedback 

after each questionò. The ñShow score after quizò option is self-explanatory. The 

ñReview missed questionsò option will allow the student, upon completion of the quiz, to 

review each question that was missed. 

 

Settings for Crosswords allow control of the number of puzzles (or ñroundsò) included in 

published activity (ranging from 1-10). Another setting determines when puzzles are 

recompiled in the StudyMate authoring tool: each time the Preview task is started or only 

when a change has occurred to the StudyMate file.  

 

Finally, note that the Matching activity requires a minimum of 9 items and that the 

Challenge activity requires a minimum of 10 items. 
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Other Settings 

The Other Settings tab, available from the Settings menu, provides language, template, 

color, and accessibility settings for the activities that are created with StudyMate Author.  

Language Settings 

 

The user interface for the activities created with StudyMate Author can appear in six 

languages: Dutch, English, Finnish, French, German, and Spanish. To change the 

language setting within StudyMate Author, select the Settings menu, click the ñOther 

Settingsò tab and then choose the desired language from the pull-down list under 

ñLanguage Settings.ò 

 

StudyMate.com Template Design 

The background template used for activities published to StudyMate.com can be changed 

to one of several available options.  To change the background template design within 

StudyMate Author, select the Settings menu, click the ñOther Settingsò tab and then 

choose the desired background design from the pull-down list under ñStudyMate.com 

Template Design.ò 

 

Color Settings 

The color settings are only applicable when exporting activities as Adobe Flash modules 

and do not apply for activities published to StudyMate.com. A total of eight color 

templates are available in StudyMate Author. The default color setting is ñClassic.ò The 

color setting you choose will determine the look of the activities and games that are 

previewed or published with StudyMate Author. Note that if a ñlanguage settingò is 

anything other than English, that only the ñClassicò color setting can be used.  

 

Accessibility Support 

The color settings are only applicable when exporting activities as Adobe Flash modules 

and do not apply for activities published to StudyMate.com. Flash activities and games 

created with StudyMate Author allow navigation using the Tab/Enter keys, an important 

component of Section 508 (United States), SENDA Compliance (United Kingdom), and 

the Web Accessibility Initiative.  

 

The activities exported as Adobe Flash modules will display in ñhigh contrastò mode if 

the ñHigh contrast display...ò setting is selected.  

 

Another setting allows the creation of an HTML page that contains alternative text for 

screen reader applications. The web page created will contain all of the underlying data 

from the StudyMate file and can be used with assistive technologies compatible with web 

browsers, including input, magnification and screen reader technologies. If images appear 

in the StudyMate file, they will be replaced with the alternate text entered by the content 

author. 

 

More detailed information about StudyMate compliance with accessibility and assistive 

technologies is available from the Respondus web site at: 

http://www.respondus.com/products/accessibility.shtml. 
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Preview & Publish Menu 

Overview 

Preview Task 

Publish Wizard 

Publishing to a Learning Management System 

Publishing to StudyMate.com Only 

Exporting as Learning Objects 

Print Options 

 

Overview 

The Preview & Publish Menu contains two tasks: Preview and Publish Wizard. The 

Preview task is used to preview the complete activities, while the Publish Wizard is used 

to generate and output the activities.  

 

Preview 

The Preview task is similar to the preview option that appears in the Edit menu. The 

primary difference here is that all items in the file can be previewed, not just the item 

being edited.  

 

Upon selecting the Preview option, a browser-like window will appear and will show 

what the activities will look like when it is published from StudyMate Author. An 

ñActivityò list appears at the top of the window and allows you to change the preview to 

a different activity. Note that the Activity list only displays the activities that are 

available for the file currently open. For example, if the StudyMate file only contains 

Multiple Choice items, the Preview task will only list the Practice Quiz and Challenge 

activities. Likewise, if the file only contains Term/Definition items, it will exclude the 

Practice Quiz and Challenge activities from the Preview task. 

 

During the preview, two options are available at the top right corner of the Flash object: 

ñMark for Deleteò and ñEdit this Itemò. ñMark for Deleteò creates a list of items to be 

deleted once the Flash object is closed (youôll be asked to confirm the deletions at that 

time). ñEdit this Itemò will close the Preview task immediately and display the item in the 

StudyMate Edit menu.  

 

The previewed activities can be viewed with the Settings selections applied or without 

the Settings applied. In most situations youôll want to see how the Settings (such as 

question randomization) affect the display of the activities, but there are times when the 

original file order is preferred for previewing and editing purposes. Select the desired 

option before clicking the Preview button.  

 

 

Publish Wizard 

The Publish Wizard is available from the Preview & Publish menu and will guide you 

through the steps of publishing or exporting the final StudyMate activities. 
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The first page of the wizard lists the activities and games that can be included with the 

activities that are being output. Deselect any activity that you want excluded from the 

output. 

 

 
 












































